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Note:

Complete information on using some filters is available in
other sections. Search Adobe Help for information on the
sharpening, blurring, Lens Correction, Lens Blur, Noise
Reduction, Liquify, and Vanishing Point filters.

List of filters supporting 16-bit/channel
and 32-bit/channel documents

The following filters support 16-bit/channel and 32-
bit/channel documents:

All Blur filters (except for Lens Blur and Smart Blur)

All Distort filters

The Noise > Add Noise filter

All Pixelate filters

All Render filters (except for Lighting Effects)

All Sharpen filters (except for Sharpen Edges)

The following filters under Filter > Stylize:

Diffuse

Emboss

Trace Contour

All Video filters

All filters under Filter > Other
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Video | Hiding sensitive information in images

Artistic filters

Filters from the Artistic submenu help you achieve painterly
and artistic effects for a fine arts or commercial project. For
example, use the Cutout filter for collages or typography.
These filters replicate natural or traditional media effects. All
the Artistic filters can be applied through the Filter Gallery.

Photoshop Playbook: Hiding Sensitive Information in Images

Photoshop Principal Product Manager Bryan O'Neil Hughes explains how to use blur and filters to hide sensitive information in th
episode of the Photoshop Playbook.

Bryan O'Neil Hughes
http://www.photoshop.com/people/bryan
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Colored Pencil

Cutout

Dry Brush

Film Grain

Fresco

Neon Glow

Paint Daubs

Draws an image using colored pencils on a solid background.
Edges are retained and given a rough crosshatch
appearance; the solid background color shows through the
smoother areas.

Note:

For a parchment effect, change the background color just
before applying the Colored Pencil filter to a selected area.

Makes an image appear as though it were
constructed from roughly cut pieces of colored paper. High-
contrast images appear as if in silhouette, and colored
images are built up from several layers of colored paper.

Paints the edges of the image using a dry brush
technique (between oil and watercolor). The filter simplifies
an image by reducing its range of colors to areas of common
color.

Applies an even pattern to the shadow tones
and midtones. A smoother, more saturated pattern is added
to the lighter areas. This filter is useful for eliminating
banding in blends and visually unifying elements from
various sources.

Paints an image in a coarse style using short,
rounded, and hastily applied daubs.

Adds various types of glows to the objects in
an image. This filter is useful for colorizing an image while
softening its look. To select a glow color, click the glow box,
and select a color from the Color Picker.

Lets you choose from various brush sizes
(from 1 to 50) and types for a painterly effect. Brush types
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Palette Knife

Plastic Wrap

Poster Edges

Rough Pastels

Smudge Stick

Sponge

Underpainting

Watercolor

include Simple, Light Rough, Dark Rough, Wide Sharp, Wide
Blurry, and Sparkle.

Reduces detail in an image to give the effect
of a thinly painted canvas that reveals the texture
underneath.

Coats the image in shiny plastic, accentuating
the surface detail.

Reduces the number of colors in an image
(posterizes it) according to the posterization option you set,
and finds the edges of the image and draws black lines on
them. Large broad areas have simple shading, and fine dark
detail is distributed throughout the image.

Applies strokes of pastel chalk on a textured
background. In areas of bright color, the chalk appears thick
with little texture; in darker areas, the chalk appears scraped
off to reveal the texture.

Softens an image using short diagonal
strokes to smudge or smear the darker areas. Lighter areas
become brighter and lose detail.

Creates images with highly textured areas of
contrasting color, simulating the effect of sponge painting.

Paints the image on a textured background,
and then paints the final image over it.

Paints the image in a watercolor style using a
medium brush loaded with water and color, simplifying
details. Where significant tonal changes occur at the edges,
the filter saturates the color.
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Average

Blur and Blur More

Blur filters

The Blur filters soften a selection or an entire image, and are
useful for retouching. They smooth transitions by averaging
the pixels next to the hard edges of defined lines and shaded
areas in an image.

Before (left) and after (right) using the Lens Blur filter; the
background is blurred but the foreground stays sharp.

Note:

To apply a Blur filter to the edges of a layer, deselect the Lock
Transparent Pixel option in the Layers panel.

Finds the average color of an image or selection,
and then fills the image or selection with the color to create
a smooth look. For example, if you select an area of grass,
the filter changes the area into a homogeneous patch of
green.

Eliminate noise where significant color
transitions occur in an image. Blur filters smooth transitions
by averaging the pixels next to the hard edges of defined
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Box Blur

Gaussian Blur

Lens Blur

Motion Blur

Radial Blur

lines and shaded areas. The effect of the Blur More filter is
three or four times stronger than that of the Blur filter.

Blurs an image based on the average color value
of neighboring pixels. This filter is useful for creating special
effects. You can adjust the size of the area used to calculate
the average value for a given pixel; a larger radius results in
greater blurring.

Quickly blurs a selection by an adjustable
amount. Gaussian refers to the bell-shaped curve that is
generated when Photoshop applies a weighted average to
the pixels. The Gaussian Blur filter adds low-frequency detail
and can produce a hazy effect. NNoottee: When Gaussian Blur,
Box Blur, Motion Blur, or Shape Blur are applied to a selected
image area, they will sometimes produce visually unexpected
results near the edges of the selection. This is because these blur
filters will use image data from outside the selected area to
create the new, blurred pixels inside the selected area. For
example, if the selection represents a background area that you
want to blur while keeping the foreground sharp, the edges of
the blurred background area will be contaminated with colors
from the foreground, producing a fuzzy, muddy-looking outline
around the foreground. To avoid this effect in such cases, you
can use Smart Blur or Lens Blur.

Adds blur to an image to give the effect of a
narrower depth of field so that some objects in the image
stay in focus and others areas are blurred. See Add lens blur.

Blurs in the specified direction (from –360º to
+360º) and at a specified intensity (from 1 to 999). The filter’s
effect is analogous to taking a picture of a moving object
with a fixed exposure time.

Simulates the blur of a zooming or rotating
camera to produce a soft blur. Choose Spin to blur along
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Shape Blur

Smart Blur

Surface Blur

concentric circular lines, and then specify a degree of
rotation. Choose Zoom to blur along radial lines, as if
zooming into or out of the image, and specify a value from 1
to 100. Blur quality ranges from Draft (for fast but grainy
results) or Good and Best for smoother results, which are
indistinguishable from each other except on a large
selection. Specify the origin of the blur by dragging the
pattern in the Blur Center box.

Uses the specified kernel to create the blur.
Choose a kernel from the list of custom shape presets, and
use the radius slider to adjust its size. You can load different
shape libraries by clicking the triangle and choosing from the
list. Radius determines the size of the kernel; the larger the
kernel, the greater the blur.

Blurs an image with precision. You can specify
a radius, a threshold, and a blur quality. The Radius value
determines the size of the area searched for dissimilar pixels.
The Threshold value determines how dissimilar the pixels
must be before they are affected. You also can set a mode
for the entire selection (Normal) or for the edges of color
transitions (Edge Only and Overlay Edge). Where significant
contrast occurs, Edge Only applies black-and-white edges,
and Overlay Edge applies white.

Blurs an image while preserving edges. This
filter is useful for creating special effects and for removing
noise or graininess. The Radius option specifies the size of
the area sampled for the blur. The Threshold option controls
how much the tonal values of neighboring pixels must
diverge from the center pixel value before being part of the
blur. Pixels with tonal value differences less than the
Threshold value are excluded from the blur.

Brush Stroke filters
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Accented Edges

Angled Strokes

Crosshatch

Dark Strokes

Ink Outlines

Spatter

Sprayed Strokes

Sumi‑e

Like the Artistic filters, the Brush Stroke filters give a
painterly or fine-arts look using different brush and ink
stroke effects. Some of the filters add grain, paint, noise, edge
detail, or texture. All the Brush Stroke filters can be applied
through the Filter Gallery.

Accentuates the edges of an image. When
the edge brightness control is set to a high value, the accents
resemble white chalk; when set to a low value, the accents
resemble black ink.

Repaints an image using diagonal strokes,
with lighter and darker areas painted in strokes going in
opposite directions.

Preserves the details and features of the
original image while adding texture and roughening the
edges of the colored areas with simulated pencil hatching.
The Strength option (with values from 1 to 3) determines the
number of hatching passes.

Paints dark areas with short, tight, dark
strokes, and lighter areas with long, white strokes.

Redraws an image with fine narrow lines over
the original details, in pen-and-ink style.

Replicates the effect of a spatter airbrush.
Increasing the options simplifies the overall effect.

Repaints an image, using its dominant
colors, with angled, sprayed strokes of color.

Paints an image in Japanese style, as if with a fully
saturated brush applied to rice paper. Sumi‑e creates soft,
blurred edges with rich, inky blacks.
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Diffuse Glow

Displace

Glass

Ocean Ripple

Pinch

Polar Coordinates

Distort filters

The Distort filters geometrically distort an image, creating 3D
or other reshaping effects. Note that these filters can be very
memory-intensive. The Diffuse Glow, Glass, and Ocean
Ripple filters can be applied through the Filter Gallery.

Renders an image as though it were viewed
through a soft diffusion filter. The filter adds see-through
white noise, with the glow fading from the center of a
selection.

Uses an image, called a displacement map, to
determine how to distort a selection. For example, using a
parabola-shaped displacement map, you can create an
image that appears to be printed on a cloth held up by its
corners.

Makes an image appear as if it were being viewed
through different types of glass. You can choose a glass effect
or create your own glass surface as a Photoshop file and
apply it. You can adjust scaling, distortion, and smoothness
settings. When using surface controls with a file, follow the
instructions for the Displace filter.

Adds randomly spaced ripples to the surface
of the image so that it appears to be underwater.

Squeezes a selection. A positive value up to 100%
shifts a selection toward its center; a negative value up
to – 100% shifts a selection outward.

Converts a selection from its
rectangular to polar coordinates, and vice versa, according to
a selected option. You can use this filter to create a cylinder
anamorphosis—an art form popular in the 18th century—in
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Ripple

Shear

Spherize

Twirl

Wave

ZigZag

which the distorted image appears normal when viewed in a
mirrored cylinder.

Creates an undulating pattern on a selection, like
ripples on the surface of a pond. For greater control, use the
Wave filter. Options include the number and size of ripples.

Distorts an image along a curve. Specify the curve
by dragging the line in the box. You can adjust any point
along the curve. Click Default to change the curve back to a
straight line. In addition, you choose how to treat undistorted
areas.

Gives objects a 3D effect by wrapping a selection
around a spherical shape, distorting the image and stretching
it to fit the selected curve.

Rotates a selection more sharply in the center than at
the edges. Specifying an angle produces a twirl pattern.

Works much as the Ripple filter does, but with
greater control. Options include the number of wave
generators, wavelength (distance from one wave crest to the
next),  height of the wave, and wave type: Sine (rolling),
Triangle, or Square. The Randomize option applies random
values. You can also define undistorted areas.

Distorts a selection radially, depending on the
radius of the pixels in your selection. The Ridges option sets
the number of direction reversals of the zigzag from the
center of the selection to its edge. You also specify how to
displace the pixels: Pond Ripples displaces pixels to the
upper-left or lower right, Out From Center displaces pixels
toward or away from the center of the selection, and Around
Center rotates pixels around the center.
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Add Noise

Despeckle

Dust & Scratches

Median

Noise filters

The Noise filters add or remove noise, or pixels with
randomly distributed color levels. This helps to blend a
selection into the surrounding pixels. Noise filters can create
unusual textures or remove problem areas, such as dust and
scratches.

Applies random pixels to an image, simulating
the effect of shooting pictures on high-speed film. You can
also use the Add Noise filter to reduce banding in feathered
selections or graduated fills or to give a more realistic look to
heavily retouched areas. Options for noise distribution
include Uniform and Gaussian. Uniform distributes color
values of noise using random numbers between 0 and plus
or minus the specified value, creating a subtle effect.
Gaussian distributes color values of noise along a bell-
shaped curve, creating a speckled effect. The
Monochromatic option applies the filter to only the tonal
elements in the image without changing the colors.

Detects the edges in an image (areas where
significant color changes occur) and blurs all of the selection
except those edges. This blurring removes noise while
preserving detail.

Reduces noise by changing dissimilar
pixels. To achieve a balance between sharpening the image
and hiding defects, try various combinations of Radius and
Threshold settings. Or apply the filter to selected areas in the
image. See also Apply the Dust And Scratches filter.

Reduces noise in an image by blending the
brightness of pixels within a selection. The filter searches the
radius of a pixel selection for pixels of similar brightness,
discarding pixels that differ too much from adjacent pixels,
and replaces the center pixel with the median brightness
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Reduce Noise

Color Halftone

Crystallize

Facet

Fragment

Mezzotint

value of the searched pixels. This filter is useful for
eliminating or reducing the effect of motion on an image.

Reduces noise while preserving edges
based on user settings affecting the overall image or
individual channels. See Reduce image noise and JPEG
artifacts.

Pixelate filters

The filters in the Pixelate submenu sharply define a selection
by clumping pixels of similar color values in cells.

Simulates the effect of using an enlarged
halftone screen on each channel of the image. For each
channel, the filter divides the image into rectangles and
replaces each rectangle with a circle. The circle size is
proportional to the brightness of the rectangle. See Apply
the Color Halftone filter.

Clumps pixels into a solid color in a polygon
shape.

Clumps pixels of solid or similar colors into blocks of
like-colored pixels. You can use this filter to make a scanned
image look hand-painted or to make a realistic image
resemble an abstract painting.

Creates four copies of the pixels in the selection,
averages them, and offsets them from each other.

Converts an image to a random pattern of
black-and-white areas or of fully saturated colors in a color
image. To use the filter, choose a dot pattern from the Type
menu in the Mezzotint dialog box.
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Mosaic

Pointillize

Clouds

Difference Clouds

Fibers

Clumps pixels into square blocks. The pixels in a
given block are the same color, and the colors of the blocks
represent the colors in the selection.

Breaks up the color in an image into randomly
placed dots, as in a pointillist painting, and uses the
background color as a canvas area between the dots.

Render filters

The Render filters create 3D shapes, cloud patterns,
refraction patterns, and simulated light reflections in an
image. You can also manipulate objects in 3D space, create
3D objects (cubes, spheres, and cylinders), and create texture
fills from grayscale files to produce 3D-like effects for
lighting.

Generates a soft cloud pattern using random values
that vary between the foreground and the background
colors. To generate a more stark cloud pattern, hold down Alt
(Windows) or Option (Mac OS) as you choose Filter >
Render > Clouds. When you apply the Clouds filter, the
image data on the active layer is replaced.

Uses randomly generated values that
vary between the foreground and background color to
produce a cloud pattern. The filter blends the cloud data with
the existing pixels in the same way the Difference mode
blends colors. The first time you choose this filter, portions of
the image are inverted in a cloud pattern. Applying the filter
several times creates rib and vein patterns that resemble a
marble texture. When you apply the Difference Clouds filter,
the image data on the active layer is replaced.

Creates the look of woven fibers using the
foreground and background colors. You use the Variance
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Lens Flare

slider to control how the colors vary (a low value produces
long streaks of color, and a high value results in very short
fibers with more varied distribution of color). The Strength
slider controls how each fiber looks. A low setting produces a
loose weave, and a high setting produces short, stringy
fibers. Click the Randomize button to change how the
pattern looks; you can click the button a number of times
until you find a pattern you like. When you apply the Fibers
filter, the image data on the active layer is replaced.

Note:

Try adding a gradient map adjustment layer to colorize the
fibers.

Simulates the refraction caused by shining a
bright light into a camera lens. Specify a location for the
center of the flare by clicking anywhere inside the image
thumbnail or by dragging its cross hair.
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Lighting Effects

Video | Adding & Removing Lens Flare

Lets you produce myriad lighting effects
on RGB images by varying 17 light styles, three light types,
and four sets of light properties. You can also use textures
from grayscale files (called bump maps) to produce 3D-like
effects and save your own styles for use in other images. See
Add Lighting Effects. NNoottee: Lighting Effects is unavailable in
64-bit versions of Mac OS.

Photoshop Playbook: Adding & Removing Lens Flare

Photoshop Principal Product Manager Bryan O'Neil Hughes explains how to add and remove lens flare from an image in this epis
of Photoshop Playbook.

Adobe Photoshop
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Sharpen and Sharpen More

Sharpen Edges and Unsharp Mask

Smart Sharpen

Sharpen filters

The Sharpen filters focus blurred images by increasing the
contrast of adjacent pixels.

Focus a selection and
improve its clarity. The Sharpen More filter applies a stronger
sharpening effect than does the Sharpen filter.

Find the areas in the
image where significant color changes occur and sharpen
them. The Sharpen Edges filter sharpens only edges while
preserving the overall smoothness of the image. Use this
filter to sharpen edges without specifying an amount. For
professional color correction, use the Unsharp Mask filter to
adjust the contrast of edge detail and produce a lighter and
darker line on each side of the edge. This process
emphasizes the edge and creates the illusion of a sharper
image.

Sharpens an image by letting you set the
sharpening algorithm or control the amount of sharpening
that occurs in shadows and highlights. This is the
recommended way to sharpen if you don’t have a particular
sharpening filter in mind. See Sharpen using Smart Sharpen.
In Photoshop CC, the enhanced Smart Sharpen filter
empowers you to produce high-quality results through
adaptive sharpening technology that minimizes noise and
halo effects. The streamlined UI design for this filter offers
optimized controls for targeted sharpening. Use the sliders
for quick adjustments and advanced controls to fine-tune
your results. Smart sharpening in Photoshop CC supports
CMYK. Additionally, you can sharpen arbitrary channels. For
example, you can choose to sharpen just the blue channel,
green channel, or the alpha channel.
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(Photoshop CC) Enhanced Smart Sharpen filter UI

Here is a recommended approach to sharpening images with
Photoshop CC:

To begin, set Amount to a high value.1. 

Increase the Radius to a value that introduces a halo
effect.

2. 

Decrease the Radius until the halo effect disappers.
You've arrived at the optimal value for Radius.

3. 

Now, decrease the Amount value as necessary.4. 

Adjust the Reduce Noise slider, such that the noise in the
image looks similar to how it was before you began
sharpening the image. Too much noise reduction can
result in a plasticy look. Higher Amount values require
greater noise reduction.

5. 

Sketch filters

Filters in the Sketch submenu add texture to images, often
for a 3D effect. The filters also are useful for creating a fine-
arts or hand-drawn look. Many of the Sketch filters use the
foreground and background color as they redraw the image.
All the Sketch filters can be applied through the Filter
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Bas Relief

Chalk & Charcoal

Charcoal

Chrome

Conté Crayon

Graphic Pen

Gallery.

Transforms an image so that it appears carved
in low relief and lit to accent the surface variations. Dark
areas of the image take on the foreground color, and light
colors use the background color.

Redraws highlights and midtones with a
solid midtone gray background drawn in coarse chalk.
Shadow areas are replaced with black diagonal charcoal
lines. The charcoal is drawn in the foreground color; the
chalk, in the background color.

Creates a posterized, smudged effect. Major
edges are boldly drawn, and midtones are sketched using a
diagonal stroke. Charcoal is the foreground color, and the
background is the color of the paper.

Renders the image as if it had a polished chrome
surface. Highlights are high points, and shadows are low
points in the reflecting surface. After applying the filter, use
the Levels dialog box to add more contrast to the image.

Replicates the texture of dense dark and
pure white Conté crayons on an image. The Conté Crayon
filter uses the foreground color for dark areas and the
background color for light areas. For a truer effect, change
the foreground color to one of the common Conté Crayon
colors (black, sepia, or sanguine) before applying the filter.
For a muted effect, change the background color to white,
add some of the foreground color to the white background,
and then apply the filter.

Uses fine, linear ink strokes to capture the
details in the original image. The effect is especially striking
with scanned images. The filter replaces color in the original
image, using the foreground color for ink and the
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Halftone Pattern

Note Paper

Photocopy

Plaster

Reticulation

Stamp

Torn Edges

Water Paper

background color for paper.

Simulates the effect of a halftone screen
while maintaining the continuous range of tones.

Creates an image that appears to be
constructed of handmade paper. This filter simplifies images
and combines the effects of the Stylize > Emboss and
Texture > Grain filters. Dark areas of the image appear as
holes in the top layer of paper, revealing the background
color.

Simulates the effect of photocopying an image.
Large dark areas tend to be copied only around their edges,
and midtones fall away to either solid black or solid white.

Molds an image from 3D plaster, and then colorizes
the result using the foreground and background color. Dark
areas are raised, and light areas are recessed.

Simulates the controlled shrinking and
distortion of film emulsion to create an image that appears
clumped in the shadows and lightly grained in the highlights.

Simplifies the image so that it appears to be created
with a rubber or wood stamp. This filter is best used with
black-and-white images.

Reconstructs the image so that it appears
composed of ragged, torn pieces of paper, and then colorizes
the image using the foreground and background colors. This
filter is particularly useful for text or high-contrast objects.

Uses blotchy daubs that appear painted onto
fibrous, damp paper, causing the colors to flow and blend.
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Diffuse

Emboss

Extrude

Find Edges

Glowing Edges

Stylize filters

The Stylize filters produce a painted or impressionistic effect
on a selection by displacing pixels and by finding and
heightening contrast in an image. After using filters like Find
Edges and Trace Contour that highlight edges, you can apply
the Invert command to outline the edges of a color image
with colored lines or to outline the edges of a grayscale
image with white lines.

Shuffles pixels in a selection to soften focus
according to the selected option: Normal moves pixels
randomly (ignoring color values), Darken Only replaces light
pixels with darker ones, and Lighten Only replaces dark
pixels with lighter ones. Anisotropic shuffles pixels in the
direction of the least change in color.

Makes a selection appear raised or stamped by
converting its fill color to gray and tracing the edges with the
original fill color. Options include an embossing angle (from
–360° to recess the surface, to +360° to raise the surface),
height, and a percentage (1% to 500%) for the amount of
color within the selection. To retain color and detail when
embossing, use the Fade command after applying the
Emboss filter.

Gives a 3D texture to a selection or layer. See
Apply the Extrude filter.

Identifies the areas of the image with
significant transitions and emphasizes the edges. Like the
Trace Counter filter, Find Edges outlines the edges of an
image with dark lines against a white background and is
useful for creating a border around an image.

Identifies the edges of color and adds a
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Solarize

Tiles

Trace Contour

Wind

Craquelure

neon-like glow to them. This filter can be applied
cumulatively.

Blends a negative and a positive image—similar
to exposing a photographic print briefly to light during
development.

Breaks up an image into a series of tiles, creating an
offset between the selection and its original position. You
can choose one of the following to fill the area between the
tiles: the background color, the foreground color, a reverse
version of the image, or an unaltered version of the image,
which puts the tiled version on top of the original and
reveals part of the original image underneath the tiled edges.

Finds the transitions of major brightness
areas and thinly outlines them for each color channel, for an
effect similar to the lines in a contour map. See Apply the
Trace Contour filter.

Places tiny horizontal lines in the image to create a
windblown effect. Methods include Wind; Blast, for a more
dramatic wind effect; and Stagger, which offsets the lines in
the image.

Texture filters

Use the Texture filters to simulate the appearance of depth
or substance, or to add an organic look.

Paints an image onto a high-relief plaster
surface, producing a fine network of cracks that follow the
contours of the image. Use this filter to create an embossing
effect with images that contain a broad range of color or
grayscale values.
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Grain

Mosaic Tiles

Patchwork

Stained Glass

Texturizer

De-Interlace

NTSC Colors

Adds texture to an image by simulating different kinds of
grain—Regular, Soft, Sprinkles, Clumped, Contrasty,
Enlarged, Stippled, Horizontal, Vertical, and Speckle,
available from the Grain Type menu.

Renders the image so that it appears to be
made up of small chips or tiles and adds grout between the
tiles. (In contrast, the Pixelate > Mosaic filter breaks up an
image into blocks of different-colored pixels.)

Breaks up an image into squares filled with the
predominant color in that area of the image. The filter
randomly reduces or increases the tile depth to replicate the
highlights and shadows.

Repaints an image as single-colored
adjacent cells outlined in the foreground color.

Applies a texture you select or create to an
image.

Video filters

The Video submenu contains the De-Interlace and NTSC
Colors filters.

Smooths moving images captured on video
by removing either the odd or even interlaced lines in a
video image. You can choose to replace the discarded lines
by duplication or interpolation.

Restricts the gamut of colors to those
acceptable for television reproduction, to prevent
oversaturated colors from bleeding across television scan
lines.

Photoshop filter effects reference https://helpx.adobe.com/photoshop/using/filter-effects-reference.html

23 of 27 4/12/18, 9:17 AM



Custom

High Pass

Maximum and Minimum

Other filters

Filters in the Other submenu let you create your own filters,
use filters to modify masks, offset a selection within an
image, and make quick color adjustments.

Lets you design your own filter effect. With the
Custom filter, you can change the brightness values of each
pixel in the image according to a predefined mathematical
operation known as convolution. Each pixel is reassigned a
value based on the values of surrounding pixels. This
operation is similar to the Add and Subtract calculations for
channels. You can save the custom filters you create and use
them with other Photoshop images. See Create a custom
filter.

Retains edge details in the specified radius
where sharp color transitions occur and suppresses the rest
of the image. (A radius of 0.1 pixel keeps only edge pixels.)
The filter removes low-frequency detail from an image and
has an effect opposite to that of the Gaussian Blur filter. It is
helpful to apply the High Pass filter to a continuous-tone
image before using the Threshold command or converting
the image to Bitmap mode. The filter is useful for extracting
line art and large black-and-white areas from scanned
images.

The Maximum and Minimum
filters are useful for modifying masks. The Maximum filter
has the effect of applying a spread (dilation)—spreading out
white areas and choking in black areas. The Minimum filter
has the effect of applying a choke (erosion)—shrinking white
areas and spreading out the black areas. Like the Median
filter, the Maximum and Minimum filters operate on selected
pixels. Within a specified radius, the Maximum and
Minimum filters replace the current pixel’s brightness value
with the highest or lowest brightness value of the
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Offset

surrounding pixels. These filters, especially with larger radii,
tend to promote either corners or curves in the image
contours. In Photoshop CC, you can choose from the
Preserve menu to favor squareness or roundness as you
specify the radius value.

(Photoshop CC) Preserve squareness or
roundness

Moves a selection a specified horizontal or vertical
amount, leaving an empty space at the selection’s original
location. You can fill the empty area with the current
background color, with another part of the image, or with
your choice of fill if the selection is near the edge of an
image.

Digimarc filters

The Digimarc filters embed a digital watermark into an
image to store copyright information.
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Note:

Digimarc plug-ins require a 32-bit operating system. They are
unsupported in 64-bit versions of Windows and Mac OS.

Vanishing Point

The Vanishing Point feature preserves correct perspective in
edits of images that contain perspective planes (for instance,
the sides of a building or any rectangular object).

More like this

Tutorial: Turn a photo into a painting

Tutorial: Blur the background for a focal point

Adjust image sharpness and blur

Work in Vanishing Point
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